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Chapter 1: New in this release

The following sections detail what's new in Avaya Hospitality Messaging Server 400 Installation and
Commissioning, NN42350-301 for HMS 400 Release 3.0.

Navigation:

• Features on page 7

• Other changes on page 8

Features
See the following sections for information about feature changes.

• Platform servers on page 7

• Windows 2008 operating system on page 7

• Auto Attendant on page 8

• Windows Net Send for AWU alerts on page 8

Platform servers
The Avaya Hospitality Messaging Server (HMS) 400 is installed on an HP ProLiant DL360 G7
server that is provided with the system.

The 703t server is not supported in HMS 400 Release 3.0.

 Note:
HMS 400 Release 3 is supported on the IBM X3350 server for upgrades.

For more information about platform servers, see Avaya Hospitality Messaging Server 400
Fundamentals, NN42350-104.

Windows 2008 operating system
HMS 400 Release 3.0 is a 32-bit application installed on the Windows 2008 R2 Enterprise
Edition operating system (OS ). The Windows 2008 OS ensures continued OS support from
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Microsoft and interoperability with Microsoft SQL and .NET technology. The Windows 2008
OS is included with the HMS 400 Release 3.0 software.

Upgrades from HMS 400 Release 2.0 to Release 3.0 also run the same Windows Server 2008
configuration.

Auto Attendant
Auto Attendant is now installed by default when HMS 400 Release 3.0 is installed. It is no
longer necessary to install it separately.

Windows Net Send for AWU alerts
AWU alerts through Windows Messaging Service are not available on Windows 2008. This
means Net Send can no longer be used to alert designated PCs about AWU failures

Other changes
This document contains the following other changes:

• The G.729 codec is supported in HMS 400 Release 3.0.

• Revision history on page 8

Revision history

March 2012 Standard 07.01. This document is up-issued to support Avaya Hospitality
Messaging Server 400 Release 3.0 and to reflect changes to the Internet
Explorer security settings.

New in this release
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Chapter 2: Introduction

This document explains how to install and commission the Avaya Hospitality Messaging Server 400.

 Important:
Be sure that any cable you purchase is foil-shielded for protection from EMI/RFI interference caused
by surrounding office equipment and fluorescent lights.

• Installation preparation on page 11

• Network cabling installation on page 17

• CS 1000 configuration  on page 19

• HMS 400 hardware installation on page 37

• HMS 400 software installation on page 53

• HMS 400 server commissioning on page 57

• Avaya Hospitality Messaging Server 400 system settings commissioning on page 71

• Commissioning the Avaya Hospitality Messaging Server 400 database on page 91

• Common procedures on page 111
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Chapter 3: Installation preparation

Before you install the Avaya Hospitality Messaging Server 400 application, complete the checklists
provided in this chapter.

Navigation:

• Site inspection checklist on page 11

• Preinstallation checklist on page 12

• Site preparation checklist on page 13

• Enabling Log Me In remote access on page 13

Site inspection checklist
Complete the following site inspection checklist before you install the HMS 400 hardware to
ensure the installation site is ready for the hardware installation.

Table 1: Site inspection checklist

Check Description
A water fire-retardant system is not in the chosen location. If a water
fire-retardant system is activated accidentally, it can severely damage
the server.

No heat sources are near the peripherals and ventilation.

The area is clean and clear of debris.

Adequate space is available for all equipment.

A desk, shelf, or table for the monitor, keyboard, mouse, and modem
and are available. Additional space is needed for a multi-server
environment.

An external analog phone line is available for the support modem. For
multi-server systems, one analog line and modem is required for each
server.

Enough power outlets for the server, monitor, and modem are
available. Additional power outlets are required for multi-server
systems.
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Check Description
For multi-server systems, customer-supplied 100/Gigabit BaseT Hub/
Switch and CAT5 cables are available.

Preinstallation checklist
Complete the following preinstallation checklist to be sure all required information is available
before you install the HMS 400 hardware.

Table 2: Preinstallation checklist

Check Description
Obtain the Communication Server 1000 (CS 1000) software version
and install the required dependency patches.

Yes No Is the Minibar items list and charges available?

Yes No Do you have a direct line to access the HMS 400 System?

Yes No Is one analog direct line connected to the modem or one Ethernet
connection available for Logmein or RDC connection?

Yes No Is the guest rooms and extensions list available?

Yes No Is the admin extensions list, a list of who should have a mailbox, and
the required CoS available?

Obtain Room and Maid Status Codes from the Hotel PMS.

Obtain Language Codes from the Hotel PMS.

Obtain the Hotel PMS IP Address and Port Number.

Obtain the CS 1000 ELAN IP address, PTY Number, and UCM user
name and password.

 Note:
Serial connections are not supported in HMS 400 Release 3.0 and
LAPW passwords are only used on CS 1000 Release 5.5 and
lower.

Obtain the most recent CS 1000 PMSI patches.

Installation preparation
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Site preparation checklist
Complete the following site preparation checklist before you install the HMS 400 hardware to
ensure all installation requirements are met.

Table 3: Site preparation checklist

Check Description
Complete site inspection checklist. See Site inspection checklist on
page 11.

Complete preinstallation checklist. See Preinstallation checklist on
page 12.

A sufficient number of power outlets with an AC rating of 110 V or 220
V are available.

A UPS of at least 400 VA with Power Management software is
available.

Two LAN points or a connection to a network switch is available.

For remote technical support, use the N0172251 modem. North
American customers can order the N0172251 modem from Avaya.
Customers outside of North America must supply their own USB
modem.

Enabling Log Me In remote access
About this task
The Log Me In application (logmein) is used to access the HMS 400 system.

Access to logmein may be blocked by Internet Explorer indicating security levels are too high.
Use this procedure to add logmein to your list of trusted sites.

Procedure

1. Open Internet Explorer.

2. Click Tools > Internet Options.
 

Site preparation checklist
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3. Under the Security tab, click Trusted Sites

4. Click Sites.

5. In the Trusted Sites window, type https://secure.logmeinrescue.com in the Add this
website to the zone field.

6. Click Close to close the Trusted Sites window.

7. In the Internet Options window, click the Advanced tab.

8. Scroll down to Security in the Settings list box and uncheck Do not save encrypted
pages to disk.
 

Installation preparation
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9. Restart Internet Explorer.

Enabling Log Me In remote access
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Chapter 4: Network cabling installation

This chapter provides information about installing network cables for an Avaya Hospitality Messaging
Server 400 system. Individual sites can have unique cable requirements. The interface between the Avaya
HMS 400, Avaya Communication Server 1000 (Avaya CS 1000), and Property Management System
(PMS) uses customer-supplied equipment.

 Important:
The customer must supply all cables.

Navigation:

• HMS 400 PMSI IP connections on page 17

HMS 400 PMSI IP connections
You can connect the HMS 400 PMSI connections to the Hotel PMS and the PMS port on the
CS 1000 using IP. TCP/IP offers enhanced communication. TCP/IP does not require line
boosters over long distances to provide higher transaction speeds and lower loss of data
packets.

You can use either a CAT5 or CAT6 cable for interconnectivity. Because the HMS 400 server
has only two LAN ports, to support IP connectivity (one for SIP and two for PMSI), all interfaces
(CS 1000, HMS 400, and Hotel PMS) must be on the same domain and must connect to a
dedicated network switch. The following diagram shows the connections between the CS 1000,
HMS 400 and Hotel PMS.
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Figure 1: HMS 400 PMSI IP connections

For information about configuring the CS 1000 for PMSI over TCP/IP, see CS 1000
configuration  on page 19. For information about configuring the HMS 400, see HMS 400
server commissioning on page 57.

Network cabling installation
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Chapter 5: CS 1000 configuration

About this task
This chapter provides information about configuring Avaya Communication Server 1000 (CS 1000) to
connect to the Avaya Hospitality Messaging Server 400 (HMS 400) Release 3.0.

The HMS 400 connects to Session Initiation Protocol (SIP) virtual trunks on the CS 1000. The CS 1000
handles incoming and outgoing call processing tasks and the HMS 400 handles RTP sessions and DTMF
transmission and processing. Up to 120 simultaneous SIP sessions can be established between the HMS
400 and CS 1000.

Prerequisites:

• For more information about CS 1000 topics such as the CS 1000 Element Manager and connecting
to the Call Server, see the CS 1000 documentation.

• The only supported codecs are G.711 and G.729.
• The maximum number of channels for each server is 120.

 Important:
An additional Signaling Server node is required for SIP interoperability between CS 1000 and other
end points.

• You must configure virtual D-channel, SIP routes, and up to 120 virtual SIP trunks for CS 1000.

CS 1000 configuration procedures
The following task flow shows you the sequence of procedures you perform to configure a CS
1000.
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CS 1000 configuration navigation

Figure 2: CS 1000 configuration procedures

CS 1000 configuration navigation:

• Checking LDN0 on page 21

• Defining LDN0 on page 21

• Defining customer support for ISDN on page 22

• Configuring the SIP gateway on page 22

• Enabling a SIP virtual trunk on page 24

• Creating a virtual D-Channel on page 25

CS 1000 configuration

20     Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Hospitality Messaging Server 400 Installation and Commissioning


• Configuring zones (LD 117) on page 25

• Creating a virtual route (LD 16) on page 27

• Creating virtual trunks (LD 14) on page 28

• Enabling the D-Channel on page 29

• Checking codec and QoS settings on page 29

• Creating the HMS 400 pilot number on page 30

• Creating a PMS PTY port on page 31

• Creating additional PTY ports on page 32

• Configuring PMSI login with UCM on Security Domain on page 33

• Confirming subscribers on page 34

• Creating an ACD queue on page 35

Checking LDN0
About this task
Determine if LDN0 is defined or not defined on the Call Server. LDN0 is used as an attendant
DN.

Procedure

1. At a command prompt on the Call Server, type LD 21 and press Enter.

2. At the REQ prompt, type PRT and press Enter.

3. At the TYPE prompt, type ldn_data and press Enter.

4. At the CUST prompt, type the customer number and press Enter.

5. Check that LDN0 is defined.

Defining LDN0
About this task
Define LDN0 on the Call Server.

Procedure

1. At a command prompt on the Call Server, type LD 15 and press Enter.

Checking LDN0
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2. At the REQ prompt, type CHG and press Enter.

3. At the TYPE prompt, type ldn_data and press Enter.

4. At the CUST prompt, type the customer number and press Enter.

5. At the LDN0 prompt, type the published directory number and press Enter.

Defining customer support for ISDN
About this task
Define customer support for ISDN.

Prerequisites:

• Log on to the CS 1000 Element Manager.

Procedure

1. In the Element Manager navigation pane, click Customers.

2. Click the customer number used for HMS 400 integration.

3. Click Feature Packages.

4. In the list of available features, expand Integrated Services Digital Network -
Package 145.

5. In the Integrated Services Digital Network - Package 145 section, select the
Integrated Services Digital Network check box.

6. In the Private Network Identifier box, type a value for a private network identifier.
Record and/or remember this value.

7. Click Save.

Configuring the SIP gateway
About this task
Configure the SIP gateway in the CS 1000 Element Manager.

CS 1000 configuration
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Prerequisites:

• To confirm which route is configured as SIP, print (PRT) your route data block (RDB) in
LD 21.

• Log on to the CS 1000 Element Manager.

Procedure

1. In the Element Manager navigation pane, select System > IP Network > Nodes:
Servers, Media Cards.
The IP Telephony Node page appears.

2. On the IP Telephony Node page, click the Node ID of the node to configure.
The Node Details page for the selected node appears

3. Click on the Gateway (SIPGw) link.
The Virtual Trunk Gateway Configuration Details page appears.

4. At the top of the page, select the Enable Gateway service on this node check
box.

5. In the General pane, in the Vtrk Gateway Application: drop-down list, select SIP
Gateway (SIPGw).

6. In the SIP Domain Name field, enter the customer domain or HMS400R3.

7. In the Local SIP Port field, type 5060.

8. In the Gateway endpoint name: field, enter HMS400R3.

9. Under SIP Gateway Settings, from the drop-down list, select Security Disabled
in TLS Security.

10. In the Primary TLAN IP Address field, type the HMS 400 TLAN IP address.

11. In the Port box, type 5060.

12. From the Transport protocol drop-down list, select a transport protocol.

13. In the Options section, ensure the Supports Registration check box is cleared.

14. Scroll down to the SIP URI Map: section.

15. In the Private Domain Names section, in the UDP: field, type the L1 domain.

16. In the CDP: field, type the L0 and L1 domains in the format: <L0
domain.L1domain>.

17. Click Save.

18. Click Save again.

19. Click Transfer Now.

20. Select the HMS 400 Node Signaling Server and click Start Sync.

21. Click OK to accept the confirmation prompt.

Configuring the SIP gateway
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22. When the transfer is complete, click OK.

23. . After the transfer completes, check the node and click Restart Application.

Enabling a SIP virtual trunk
About this task
Enable a SIP virtual trunk in the CS 1000 Element Manager.

Prerequisites:

• Log on to the CS 1000 Element Manager.
• The SIP domain name must not exceed 128 characters. Valid characters are the letters

a to z, numbers 0 to 9, period (.), hyphen (-), comma (,), and underscore (_).

Procedure

1. In the Element Manager navigation pane, select System > IP Network > Nodes:
Servers, Media Cards.

2. On the Node Configuration page, click Edit beside the node to configure.

3. Expand Signaling Servers.

4. Under Signaling Servers, expand Signaling Server Properties.

5. In the Signaling Server Properties section, in the Enable Line TPS list, select
SIP only.

6. Ensure that Local SIP TCP/UDP Port to Listen to is 5060.

7. In the SIP Domain name box, type the SIP domain name.
The SIP domain name builds all SIP messages and appears in the URI phone
context.

8. Click Save and Transfer.

9. If you receive a prompt to restart the SIP sever, click OK.

10. After the transfer is complete, click OK.

11. In the Element Manager navigation pane, select System > IP Network >
Maintenance and Reports.

12. In the Node Maintenance and Reports pane, expand Node ID.

13. Under Node ID, click Reset.

14. If a confirmation message appears, click OK.

CS 1000 configuration

24     Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Hospitality Messaging Server 400 Installation and Commissioning


Creating a virtual D-Channel
About this task
Create a virtual D-Channel in the CS 1000 Element Manager.

 Important:
D-Channels 0, 1, and 2 are usually used or shared with other applications. Begin configuring
virtual D-channels on Channel 3 or greater.

Prerequisites:

• Log on to the CS 1000 Element Manager.

Procedure

1. In the Element Manager navigation pane, select Routes and Trunks > D-
Channels.

2. If a D-channel is not configured, a message appears; click OK.

3. In the D-Channels page, in the Choose a D-Channel Number drop-down list,
select the desired D-Channel number.

4. In the type list, select DCH.

5. Click to Add.
The D-Channels Property Configuration page appears.

6. In the D channel Card Type (CTYP) list, select DCIP (D-Channel is over IP).

7. In the Designator (DES) field, type a meaningful name for the D-channel.
The Designator (DES) name cannot contain spaces. Use underscores (_) instead
of spaces.

8. In the User (USR) list, select Integrated Services Signaling Link Dedicated
(ISLD).

9. In the Interface type for D-channel (IFC) list, select Meridian 1 (SL1).

10. Click Submit to create the new D-channel.

Configuring zones (LD 117)
About this task
Perform this procedure to configure the zones required for virtual routes and trunks.

Creating a virtual D-Channel
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You must configure the following zones before you configure virtual routes and trunks:

• Zone 1 – Zone for IP Deskphones (ZBRN=MO)
• Zone 2 – Zone for voice gateway channels (ZBRN=VTRK)

 Important:
Do not use Zone 0.

Prerequisites:

• Log on to the CS 1000 Element Manager.
• Ensure that the bandwidth allocated for zones with heavy traffic is available.

Procedure

1. In the Element Manager navigation pane, select System > IP Network > Zones.
The Zones page appears.

2. Click Bandwidth Zones
The Bandwidth Zones page appears.

3. On the Bandwidth Zones page, if only Zone 0 exists in the Please Choose the
drop-down list:

a. Select Zone 1 in the drop-down list and click to Add.
b. Select Zone 2 in the drop-down list and click to Add.

4. Expand Bandwidth Zones 1 and select Zone Basic Property and Bandwidth
Management.
The Zone Basic Property and Bandwidth Management page appears.

5. If you are prompted to use the Zone Basic Property and Bandwidth Management
Spreadsheet, click OK.

6. On the Zone Basic Property and Bandwidth Management page, in the Zone
Intent (ZBRN) list, select MO (MO).

7. In the Description (ZDES) box, type a meaningful name for Zone 1.

8. Click Submit.

9. On the Bandwidth Zones page, expand Zone 2 and select Zone Basic Property
and Bandwidth Management.

10. If you are prompted to use the Zone Basic Property and Bandwidth Management
Spreadsheet, click OK.

11. On the Zone Basic Property and Bandwidth Management page, in the Zone
Intent (ZBRN) drop-down list, select VTRK (VTRK).

12. In the Description (ZDES) box, type a meaningful name for Zone 2.

13. Click Submit.
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Creating a virtual route (LD 16)
About this task
Create a virtual route for LD 16 in the CS 1000 Element Manager.

Prerequisites:

• Log on to the CS 1000 Element Manager.

Procedure

1. In the Element Manager navigation pane, select Routes and Trunks > Routes and
Trunks.
The Routes and Trunks page appears.

2. On the Routes and Trunks page, click Add route.

3. On the New Route Configuration page, in the Basic Configuration section, from
the Route Number (ROUT) drop-down list, select the route number.

4. In the Designator field for Trunk (DES) box, type a meaningful name for the
route.

5. In the Trunk Type (TKTP) list, select TIE Trunk data block (TIE).

6. In the Incoming and Outgoing Trunk (ICOG) list, select Incoming and Outgoing
(IAO).

7. In the Access Code for the trunk route (ACOD) box, type a value for the trunk
route access code.

8. Select the The route is for a virtual trunk route (VTRK) check box.

9. In the Zone for codec selection and bandwidth management (ZONE) box, type
the number of the zone that is configured as ZBRN=VTRK.

10. In the Node ID of signaling server of this route (NODE) box, type the node ID of
the Signaling Server.
If you are unsure of the node ID, choose System > IP Network > Node: Servers
Media Cards in the Element Manager navigation pane to find the node ID.

11. In the Protocol ID for the route (PCID) list, select SIP (SIP).

12. Select the Integrated Services Digital Network option (ISDN) check box.

13. In the Mode of operation (MODE) list, select Route uses ISDN Signaling Link
(ISLD).

14. In the D Channel number (DCH) list, select the D-channel number that you
previously configured.

15. In the Interface type for route (IFC) list, select Meridian M1 (SL1).

Creating a virtual route (LD 16)
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16. In the Private Network Identifier (PNI) box, type a value for the private network
identifier.

17. In the Call Type for outgoing direct dialed TIE route (CTYP) list, select Unknown
Call type (UKWN).

18. Select the Insert ESN Access Code (INAC) check box.

19. Click Save.
The route you created appears on the Route and Trunks page.

Creating virtual trunks (LD 14)
About this task
Create a virtual trunk for LD 14 in the CS 1000 Element Manager.

Prerequisites:

• Log on to the CS 1000 Element Manager.

Procedure

1. In the Element Manager navigation pane, select Routes and Trunks > Routes and
Trunks.
The Routes and Trunks page appears.

2. Expand the desired Customer Number.

3. Under the Customer number, click Add trunk beside the route to which you want
to add the trunk.
The New Trunk Configuration page appears.

4. On the New Trunk Configuration page, select Multiple trunk input number
(MTINPUT) if you configure multiple trunks.
The maximum number of trunks is 32.

5. In the Trunk data block (TYPE) list, select IP Trunk (IPTI).

6. In the Terminal Number (TN) box, type the trunk terminal number.

7. In the Designator field for trunk (DES) box, type a meaningful name for the
trunk.

8. Make sure that Extended Trunk (XTRK) is Virtual trunk (VTRK).

9. In the Route number, Member number (RTMB) box, type the route number and
member number separated by a space.

10. In the Start arrangement Incoming (STRI) list, select Immediate (IMM).

CS 1000 configuration

28     Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Hospitality Messaging Server 400 Installation and Commissioning


11. In the Start arrangement Outgoing (STRO) list, select Immediate (IMM).

12. In the Channel ID for this trunk (CHID) box, type the channel ID for the trunk.

13. To optionally configure a class of service, click Edit beside Class of Service
(CLS).

14. Select Advanced Trunk Configurations to optionally configure advanced options.
The default values are acceptable.

15. Click Save.

Enabling the D-Channel
About this task
After you configure routes and trunks, you must enable the D-Channel.

Prerequisites:

• Log in to the CS 1000 Element Manager.

Procedure

1. In Element Manager Navigation pane, select Routes and Trunks > D-
Channels.
The D-Channels page appears.

2. In the Maintenance section, click the D-channel Diagnostics (LD 96) link.

3. From the Enable Auto Recovery list, select Enable D-Channel (ENL DCH).

4. Select the D-Channel option to use for the HMS 400.

5. Click Submit.

Checking codec and QoS settings
About this task
Confirm codec and QoS settings in CS 1000 Element Manager.

Enabling the D-Channel
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Prerequisites:

• Log on to the CS 1000 Element Manager.

Procedure

1. In the Element Manager navigation pane, select System > IP Network > Nodes:
Servers, Media Cards.
The IP Telephony Nodes page appears.

2. Click the desired Node ID.
The Node Details page appears

3. On the right, click the Voice Gateway (VGW) and Codecs link.
The Voice Gateway (VGW) and Codecs page appears.

4. In the Voice Codecs section, make sure only the G.729A and G.711 codecs are
selected.

5. Click Save.
The Node Details page appears again.

6. Click Save.
The Node Saved window appears.

7. Click Transfer Now.
The Synchronize Configuration Files window appears.

8. Select the HMS 400 Node Signaling Server and click Start Sync.
The Synchronization Status column displays Synchronized when the
synchronization finishes.

Creating the HMS 400 pilot number
About this task
The HMS 400 pilot number is the primary number where all subscriber calls are forwarded to
in busy or no answer situations. This number is also the Night Call Forward (NCFW) destination
for all Automatic Call Distribution (ACD) queues created that access HMS 400 services.

Prerequisites:

• Create a Route List Index (RLI). For more information, see Avaya Communication Server
1000 Software Input Output Reference — Administration, NN43001-611.

Procedure

1. At a command line, type LD 87 and press Enter.
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2. At the REQ prompt, type NEW and press Enter.

3. At the FEAT prompt, type CDP and press Enter.

4. At the TYPE prompt, type DSC and press Enter.

5. At the DSC prompt, type DN for the pilot number and press Enter.

6. At the FLEN prompt, type the length of the DN and press Enter.

7. At the DSP prompt, press Enter.

8. At the RLI prompt, type the value for the Route List Block and press Enter.

Creating a PMS PTY port
About this task
Create a PMS PTY port to enable HMS 400 communication with the switch to perform functions
such as check in, check out, and Class of Service (CoS) or Class of Restriction (COR)
change.

Prerequisites:

• The PMS PTY port must be the lowest-numbered PTY port.
• Create at least two additional PTY ports that have higher port numbers than the PMS PTY

port. For information about creating additional PTY ports, see Creating additional PTY
ports on page 32.

Procedure

1. At a command line, type LD 17 and press Enter.

2. At the REQ prompt, type CHG and press Enter.

3. At the TYPE prompt, type CFN and press Enter.

4. At the ADAN prompt, type NEW TTY X (where X is the port number) and press
Enter.

5. At the CTYP prompt, type PTY and press Enter.

6. At the PORT prompt, type the port number and press Enter.
The port number range is usually 0 to 7 but it can match X.

7. At the DNUM Y prompt, press Enter.

8. At the DES prompt, type a description (for example, PMSI) and press Enter.

9. At the FLOW prompt, type NO and press Enter.

10. At the USER prompt, type BGD PMS and press Enter.

Creating a PMS PTY port
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11. At the TTYLOG prompt, type NO and press Enter.

12. At the BANR prompt, press Enter.

Creating additional PTY ports
About this task
Create at least two additional PTY ports that have port numbers greater than the PMS PTY
port.

Procedure

1. At the command prompt type LD 17 and press Enter.

2. At the REQ prompt, type CHG and press Enter.

3. At the ADAN prompt, type NEW TTY X (X is a number greater than the first port)
and press Enter.

4. At the CTYP prompt, type PTY and press Enter.

5. At the PORT prompt, type the port number and press Enter.
The port number range is usually 0 to 7 but it can match X.

6. At the DNUM Y prompt, press Enter.

7. At the DES prompt, type a description (for example, ptyY) and press Enter.

8. At the FLOW prompt, type NO and press Enter.

9. At the USER prompt, type MTC SCH BUG and press Enter.

10. At the TTYLOG prompt, type NO and press Enter.

11. At the BANR prompt, press Enter.

Configuring system parameters for PMS connectivity
About this task
Create a TTY port if the user chooses serial connectivity rather than IP (rlogin) for their PMSI
interface.

 Important:
HMS 400 Release 3.0 does not support serial connection to the CS 1000.
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Prerequisites:

• Check the status of the TTY port 1 using LD 37. If it is enabled, disable it.
• Ensure PCML and PMSI settings are configured accordingly in LD 17.

Procedure

1. At a command prompt, type LD 17 and press Enter.

2. At the REQ prompt, type CHG and press Enter.

3. At the TYPE prompt, type PARM and press Enter.

4. Press Enter until the system displays the PCML prompt.

5. Type MU or A , depending on the region you are in, and press Enter.
If you are in the NA/CALA region, type MU. If you are in the EMEA/APAC region,
type A.

6. Press Enter until the system displays the PMSI prompt.

7. Type YES and press Enter.

8. At the MANU prompt, type PMS1 and press Enter.

9. At the PMCR prompt, press Enter.

10. At the PORT prompt, enter the PTY port number created in Creating a PMS PTY
port on page 31.

11. Press Enter until the system displays the REQ prompt.

12. Type **** and press Enter to exit.

Configuring PMSI login with UCM on Security Domain
About this task
Use this procedure to configure PMSI login with UCM on Security Domain.

Procedure

1. Log in to UCM with the admin username and password.

2. Click Administrative Users.

3. Click Add to add a new user.
The username should be same as PTY built for PMS.

4. Type the password.

Configuring PMSI login with UCM on Security Domain
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 Important:
This is a temporary password. Later you are prompted to change the
password.

5. Click Save and continue.

6. Select Roles for new log in CS1000 Admin2, Network Administration, PDT2, and
Custom role HMS.

7. Click Save.

8. Log out of UCM.

9. Log in using the newly-created user.
The system prompts you to change the password. Change and save the
password.

10. Log in to the HMS 400 as superadmin and open the Web GUI page.

11. Select the PBX Setting from the left menu.

12. Select the IP Setting bubble.

13. Type the Call Server ELAN IP address.

14. Type the user name created earlier in UCM.

15. Type the password for user created earlier and update.

16. Restart HMS 400 service for the change to take effect.
After the system restarts, use the connectivity test in the PMSI to verify that the PBX
link has been successfully connected.

Confirming subscribers
About this task
Ensure that all subscriber telephones (analog (500/2500–type), digital, or IP) are programmed
with the following parameters.

 Important:
Class of service LPA is necessary for the Message Lamp to work on analog (500/2500–
type) telephones. For telephones without MW LED, use AMW and LPD to activate stutter
tone instead.

Procedure

1. Ensure Administrative telephones have the following settings:

• FDN 2000—Forward to HMS Pilot Number
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• CLS tld hta fna mwa cnia ccsa mra nama

• HUNT 2000—Hunt to HMS Pilot Number

2. Ensure Guest telephones have the following settings:

• CLS tld lpa hta fna mwa cnia ccsa mra nama

• HUNT 2000—Hunt to HMS Pilot Number

• FTR fdn 2000—Forward to Voicemail Pilot Number

 Important:
HMS 400 does not support the default Message/Inbox soft keys. Soft keys can
be suppressed by applying Product Enhancement Patch MPLR 24565.

Creating an ACD queue
About this task
Use ACD queues to access voice mail services. You can create one ACD DN for each service.
Create an ACD queue that forwards calls to the HMS 400 pilot number created in Creating the
HMS 400 pilot number on page 30.

Prerequisites:

• Print the list of HMS 400 Services (Entry Points).

Procedure

1. At a command prompt, type LD 23 and press Enter.

2. At the REQ prompt, type NEW and press Enter.

3. At the TYPE prompt, type ACD and press Enter.

4. At the CUST prompt, type 0 and press Enter.

5. At the ACDN prompt, type 7000 (or any number you want to assign) and press
Enter.

6. Press Enter until the MAXP prompt appears.

7. At the MAXP prompt, type 1 and press Enter.
This number creates one agent but forwards all callers to the NCFW number.

8. Press Enter until the NCFW prompt appears.

9. At the NCFW prompt, type the HMS 400 pilot number.

10. Press Enter until your changes are saved.

Creating an ACD queue
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Chapter 6: HMS 400 hardware installation

About this task
This chapter describes how to install the Avaya Hospitality Messaging Server 400 (HMS 400)
hardware.

HMS 400 hardware installation procedures
The following task flow shows you the sequence of procedures you perform to install the HMS
400 hardware.
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HMS 400 hardware installation procedures task flow

Figure 3: HMS 400 hardware installation procedures
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HMS 400 hardware installation navigation:

• Unpacking the HMS 400 on page 39

• Removing the server top cover on page 40

• Inspecting the server interior on page 41

• Installing the dongle (HP DL360G7 server only) on page 43

• Replacing the server top cover on page 47

• Installing the HMS 400 server on page 48

• Connecting peripherals to the HMS 400 server on page 48

• Connecting the modem to the HMS 400 server on page 49

• Connecting the HMS 400 server to power on page 50

• Starting HMS 400 server on page 51

Unpacking the HMS 400
About this task
Unpack the HMS 400 server and peripherals. After you unpack each item, check the item off
on the packing list.

 Warning:
The HMS 400 shipped from manufacturing weighs approximately 15 kilograms. Ensure you
take proper precautions to avoid injury while unpacking the server.

Procedure

1. Carefully open the cardboard carton that contains the server.

2. Remove the server from the carton and place it on the floor.

3. Carefully open the cartons that contain the keyboard and mouse and set the
peripherals aside.

4. Place all manuals, DVDs, CD-ROMs, operating system disk, any disks for
peripherals, and the Windows emergency repair disk in a safe place.

5. Save all packing materials and cartons in case you must return any equipment.

Unpacking the HMS 400
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Removing the server top cover
About this task
Remove the server top cover to work with the interior server components.

 Warning:
Risk of personal injury
Handle sharp edges of the panel and chassis carefully to prevent injury.

 Caution:
Risk of equipment damage
Use an Electrostatic Discharge (ESD) wrist strap to protect static-sensitive components.

Procedure

1. Remove the protective power-supply cover from the back of the server by pulling
the cover straight back from the power supplies.
Store the power-supply cover in a safe place.

2. To install or remove a memory module, PCI adapter, battery, or other non hot-swap
optional device, turn off the server and all attached devices and disconnect all
external cables and power cords.

3. If the server is rack-mounted, press down on the left and right side latches and pull
the server out of the rack enclosure until both slide rails lock.
You can reach the cables on the back of the server when the server is in the locked
position.

4. Loosen the thumbscrew at the back of the server.
You cannot remove the thumbscrew.

5. Slide the two cover-release latches on the fan door on the right side of the top of
the server back; then open the fan door cover.

6. Slide the server cover back until the locking tabs release.

7. Lift the server cover off the server and set the cover aside.

Job aid
The following graphics show the power supply cover, the location of the thumbscrew and the
fan door.

HMS 400 hardware installation
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Figure 4: Removing HMS 400 power-supply cover

Figure 5: HMS 400 thumbscrew and fan door

Inspecting the server interior
About this task
Before you install the server, visually inspect it for loose components, foreign matter, or
shipping damage inside the server.

 Caution:
Risk of equipment damage

Inspecting the server interior
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While you work with interior components, use an ESD wrist strap to protect static-sensitive
components. The base package does not come with this strap.

Prerequisites:

• For information about replacing the cover, see Replacing the server top cover on
page 47.

Procedure

1. Inside the server, check for loose wires or foreign objects (such as loose screws)
inside the chassis.

2. Review the slot locations.

3. If you observe any damage, contact your Avaya technical support representative.

4. If components are loose, secure the components before you install the server.

5. If the server has no damage, replace the cover before you install the server.

Job aid
The following graphic show the interior components of the HMS 400.

Figure 6: HMS 400 interior components
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Installing the dongle (HP DL360G7 server only)
About this task
The dongle for the HP DL360G7 server must be installed into the internal USB port. Follow
this procedure to install the dongle in the internal USB port..

Prerequisites:

• Obtain a flat-edge screwdriver.

Procedure

1. Obtain a flat-edge screwdriver.

2. Locate the lever on the top surface of the server.

Installing the dongle (HP DL360G7 server only)
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3. Turn the screw to the ‘unlock’ position.

4. Gently pull the lever all the way upward to open the cover of the server.

HMS 400 hardware installation
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5. Lift up the cover to remove it and then locate the internal USB port.

6. Carefully insert the USB dongle until the tip lights up.

Installing the dongle (HP DL360G7 server only)

Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012     45



7. Replace the cover and slide it back into position before pushing the lever all the way
down.

8. Turn the screw back to its lock position.

HMS 400 hardware installation
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Replacing the server top cover
About this task
Replace the server top cover after you inspect the interior for damage.

 Caution:
Risk of equipment damage
Ensure that no tools or loose parts are inside the server chassis before you replace the
cover.

Replacing the server top cover
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Procedure

1. Slide the cover forward, and ensure that all the tabs on the front, rear, and side of
the cover engage the chassis correctly.

2. Close the fan door and slide the cover release latches back to lock the cover in
place.

3. Tighten the thumbscrew on the back of the server.

Installing the HMS 400 server
About this task
Install the HMS 400 server.

Prerequisites:

• Ensure the chosen location meets the requirements defined in Site preparation checklist on
page 13.

Procedure

Install the HMS 400 server in the 19–inch equipment rack according the instructions
provided with your server.

Connecting peripherals to the HMS 400 server
About this task
Connect the monitor, keyboard, and mouse to the HMS 400 server.

 Caution:
Risk of system failure
Install and use only Avaya-approved peripheral devices. To prevent system failure, install
and use only Avaya-approved devices.

Procedure

1. Place the monitor, keyboard, and mouse in the same location as the server.

2. Plug the keyboard and mouse into the appropriate USB connectors on the front
panel of the server.
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3. Plug in the monitor connector and tighten the screws on the connector.

4. Connect the power cord to the monitor and plug the monitor into a power
receptacle.

5. Turn on the monitor.

Job aid
The following graphics show the front and rear view of the HMS 400 server.

Figure 7: HMS 400 server front view

Figure 8: HMS 400 server rear view

Connecting the modem to the HMS 400 server
About this task
A modem is required to enable remote support dial-up access to the HMS 400 server. The
modem enables Avaya technical support personnel to connect to the HMS 400 server for
troubleshooting purposes. Avaya requires that you connect the modem to your server only
when you request technical assistance.

Connecting the modem to the HMS 400 server
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Prerequisites:

• To install the modem, the following items are required:
- An analog modem that includes an analog RJ-11 analog phone cord and US Robotics

56 Kb/s USB modem. The Avaya order code for North America only is NTUB30HA.
Other regions must supply an equivalent USB modem.

- An analog line jack.

Procedure

1. To connect the modem, connect the B end of the USB A-B cable into the back of
the modem.

2. Connect the A end of the USB A-B cable into an available USB port on the rear of
the server.

3. Connect one end of the telephone cable into the modem RJ-11 jack that is labeled
LINE.

4. Connect the opposite end of the telephone cable into the RJ-11 wall jack.

Connecting the HMS 400 server to power
About this task
Ensure that proper power and grounding are available for all the power outlets that serve the
HMS 400 server and associated peripherals. Power for these devices must be wired and fused
independently of all other receptacles and referenced to the same ground as the CS 1000.
When the server connects to an AC power source but is not on, the operating system does
not run, and all core logic except for the service processor (the baseboard management
controller or optional Remote Supervisor Adapter II SlimLine) is shut down. The server can
respond to requests from the service processor, such as a remote request to turn on the server.
The power-on LED flashes to indicate that the server is connected to AC power but is not
on.

 Warning:
Use the connecting cables, power cord, and AC adaptors shipped with the equipment or
specified by Avaya. If you use any other equipment, it can cause failures, malfunctions, or
fire. Use power cords shipped only with this equipment. Not following these guidelines can
lead to death or severe injury.

 Warning:
Risk of personal injury and risk of hardware failure
You must connect the power outlets that are used by the HMS 400 server and the peripheral
devices to the same single-point ground reference as the one used by the CS 1000 switch
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connected to the HMS 400 server. If this requirement is not met, power transients can cause
personal injury, hardware failure, or both.

Procedure

1. Plug the HMS 400 server AC power cord into the HMS 400 server rear panel.

2. Plug the opposite end of the HMS 400 server AC power cord into a wall receptacle
or power bar.

Starting HMS 400 server
About this task
You can start the HMS 400 server approximately 20 seconds after the server connects to AC
power. The power-control button becomes active and one or more fans might start running to
provide cooling while the server is connected to power.

Prerequisites:

• If a power failure occurs while the server is turned on, the server restarts automatically
when power is restored.

• If you installed an optional Remote Supervisor Adapter II SlimLine, you can turn on the
server from the Remote Supervisor Adapter II SlimLine user interface.

• If your operating system supports the Wake on LAN feature, the Wake on LAN feature
can turn on the server.

Procedure

1. To start the server, press the server power switch.

2. Observe the Power-On Self-Test (POST) and initialization messages on the
monitor.

Starting HMS 400 server
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Chapter 7: HMS 400 software installation

About this task
This chapter describes how to install Avaya Hospitality Messaging Server 400 (HMS 400) software. For
new HMS 400 servers, a trained technician must install the HMS 400 system image from the system image
DVD.

For information about installing service updates, see Avaya Hospitality Messaging Server 400
Maintenance, NN42350-101.

 Important:
Do not use DHCP.

• Obtain a static IP address from the administrator for the HMS 400 server.
• Ensure that the HMS 400 server has access to the CS 1000 TLAN (Node IP) or Communication

Manager IP and to the customer LAN (for Web configuration). To connect an HMS 400 server to the
network, the hotel administrator must determine how to configure the network based on the security
or IP policies deemed appropriate, as long as the HMS 400 server has access to the CS 1000 TLAN
(Node IP) or Communication Manager IP and customer LAN (for Web Configuration).

• If the hotel administrator plans to run PMSI over IP, then the administrator can run PMSI over IP to
the hotel PMS only or to the hotel PMS and to the CS 1000. If the administrator plans to run PMSI
over IP to both the hotel PMS and to the CS 1000, the server needs to access the CS 1000 ELAN.
The number of NIC ports used depends on these factors. These factors also determine what IP
address to configure for each NIC.

• If the hotel administrator plans to run PMSI over IP to both the hotel PMS and to the CS 1000, two
NICs are required. Assign the first NIC to connect to the CS 1000 node IP (TLAN) and assign the
second NIC to connect to the ELAN.

Navigation:

• Installing or restoring the HMS 400 software image on page 53
• Configuring Dialogic HMP on page 55

Installing or restoring the HMS 400 software image
About this task
Install the HMS 400 software from an image DVD. To restore the system if a hard disk fails,
the same steps apply.
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Prerequisites:

• Ensure that you configure the BIOS to start from the DVD drive. By default, the server starts
from the DVD drive. If the DVD drive is not the default, you must configure the BIOS settings
by pressing F12 on the POST screen and selecting CD-ROM.

Procedure

1. Place the Recovery DVD into the DVD-ROM drive.

2. Exit HMS 400 and reboot the server.

3. In the Select desired operation window, select 1. Recovery CD.

4. Ensure that you read any warnings that appear and press any key to continue the
installation.

5. When the following prompt appears, type Y .
Do you wish to perform a system recovery function on this
server, which will result in a complete overwrite of all
present hard drive data? [Y/N]

6. When the following prompt appears, type Y.
Would you like to proceed with this recovery function and a
complete overwrite of all present hard drive data? [Y/N]

7. When the following prompt appears, remove the DVD from the DVD-ROM drive,
put the second DVD in the DVD-ROM drive, and click OK.
Symantec Ghost needs to open the next part of the image.
Please either insert the next disk and choose OK, or choose
Browse to select the next part of the image.

8. When the following prompt appears, remove the DVD from the DVD-ROM drive and
press Ctrl + Alt + Delete to reboot the server. .
The system recovery function has completed successfully.
Please remove all media from drives and reboot the server.
Press any key to continue...

Next steps
After the system image is installed, the field tech should always install the latest Service
Update.

For information on installing a Service Update (SU), see the “Service Updates” chapter in
Avaya Hospitality Messaging Server 400 Maintenance, NN42350–101.
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Configuring Dialogic HMP
About this task
Configure the Dialogic Host Media Processing (HMP) to enable HMS to place and receive
calls.

Procedure

1. Select Start > All Programs > Dialogic HMP > Cofiguration Manager DCM.

2. In the Configuration Manager window, right-click HMP_Software #0 in slot
0/65535 and select Configure Device.

3. In the Properties window, select the Default IP Address tab.

4. Ensure the correct IP address is bound to the HMP Drivers.

 Important:
If the wrong IP address is bound to the HMP, the system can function incorrectly;
for example, it may not detect DTMF.

5. Click OK.

6. Select Settings > System/Device autostart > Start System.

7. Close the Configuration Manager window.

8. Reboot the server.

Configuring Dialogic HMP
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Chapter 8: HMS 400 server commissioning

This chapter describes how to commission the Avaya Hospitality Messaging Server 400 (HMS 400)
server.

• Enter a valid keycode to activate the number of channels and features in the HMS 400 Keycode
Setup application that is available on the desktop.

• You must restart the HMS 400 application to apply changes.

Server configuration
This section describes how to configure an HMS 400 server.

This configuration method applies to all Avaya HMS 400 servers.

Server configuration procedures
About this task
This task flow shows you the sequence of procedures you perform to configure an HMS 400
server.
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Figure 9: Server configuration procedures
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Server configuration navigation:

• Entering a key code on page 60
• Starting the Web configuration module in a Web browser on page 61
• Starting the Web Configuration module in the Voice System application on page 114
• Changing the password on page 61

Server configuration procedures
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• Configuring a default language for system prompts on page 62
• Configuring an entry point on page 62
• Configuring the PMS setting on page 65
• Configuring Communication Server 1000 settings on page 66
• Configuring HMS 400 server settings on page 66
• Configuring the SIP Setting on page 67
• Configuring Log Printer Setting on page 68

Entering a key code
About this task
When the Web Configuration starts, the system detects the presence of a valid keycode. If a
valid keycode is not available, a Key Code alert appears. The alert message provides
information about how to address the key code issue. Ensure that the security dongle is
connected to the internal USB port on the HP ProLiant DL360 G7 server (or a free USB port
if for the IBM x3350 server) before you start the Web configuration.

Prerequisites:

• The keycode is included in an envelope with your HMS 400 shipment.
• The keycode is case-sensitive.
• For information about the location of the USB ports, see Avaya Hospitality Messaging

Server 400 Fundamentals, NN42350-104.
• On the Key Code Information window, the Security lock serial number appears in the

Serial Number box. If the serial number does not appear, the Security lock may not be
programmed or it is faulty.

Procedure

1. When the server starts, the EULA (licensing agreement) window opens. If you
agreed to the agreement, click Accept. (Accepting EULA is only done once.)

 Note:
EULA can be found at C:\HMS400R3\tools\EULA.pdf.

2. In the Key Code Information dialog box, in the Enter Key Code box, type or paste
your key code.

3. Click Verify.
If the key code is invalid, the system does not start.

4. If the key code is valid, check the Results box to confirm the number of channels
available and the active features.

5. Close the Key Code Information dialog box.
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The HMS 400 software loads automatically.

Starting the Web configuration module in a Web browser
About this task
Start Web Configuration from a Web browser to configure options for your system.

Prerequisites:

• If this is the first time you access the Web configuration module, ensure that the security
dongle connects to a free USB port on the HMS 400 server before you start Web
configuration.

Procedure

1. Open Internet Explorer and the following Web site appears by default:
https://hms400R3/hms400webui/password.aspx

2. In the HMS 400 window, in the User Type list, select Admin User.

3. In the User ID box, type the user ID.
The default User ID is SuperAdmin.

4. In the Password box, type the password.
The default password is abc123. Ensure that you immediately change this
password.

5. Click Login.

Changing the password
About this task
Change the Web configuration module password.

Prerequisites:

• The number of days a user password is valid before it expires is configured when you
create a user.

• An administrator password is valid for 60 days. If the Administrator password expires, the
administrator can log on one additional time using the old password and must create a
new password that is valid for 60 days.

• Users are reminded seven days prior to the expiry date, and every day after until the
actual expiry date, that their password is about to expire.

• The password must be six to eight alphanumeric characters.

Server configuration procedures

Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012     61



Procedure

1. On the Web Configuration main navigation bar, click Change Password.

2. On the Change Password window, in the Old Password box, type your old
password.

3. In the New Password box, type a new password.

4. In the Re-Type New Password box, retype the new password.

5. Click Update.

Configuring a default language for system prompts
About this task
Configure a default language for system prompts.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, under Hardware Settings, click
Language.

3. In the Language window, in the Default Line Language list, select the language
for the system prompts. Only installed languages are available.

4. Click Save to save your changes.

Variable Definitions

Variable Value
Default Line Language The default language for system prompts.

Configuring an entry point
About this task
Entry points function as a translation table that the system can reference to determine how to
respond to and handle a call. Ensure that you configure entry points correctly for proper system
operation.
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Entry points are comprised of two parts:

• Called/Calling Party Identification (CPI) string contains called party and calling party
information. The CPI string is transmitted by the CS 1000 every time a call is answered.

• Call Flow. For information about call flows (also known as Auto Attendant Flows or AAF),
see Avaya Hospitality Messaging Server 400 Fundamentals, NN42350-104.

The entry point format is as follows:

<Called Party>_<Calling Party>

 Note:
If using Communication Manager, do not configure an entry point for MINIBAR/Room
Status. The Intuity Lodging voicemail interface does not support sending maid status codes
or minibar inventory information to the Property Management System; therefore, the minibar
and maid status feature available on the HMS 400 with CS 1000 is not available for
Communication Manager.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, click Entry Point.

3. On the Entry Point window, in the first Entry Point Format box, type the called
party number or extension number of a specific service.

4. To configure advanced options for the calling party, select the Advanced Setting
check box.

5. If you did not select Advanced Setting, a W appears in the second Entry Point Format
box as the Calling Party.
If you do not configure Advanced Setting, W is the only option available for Calling
Party.

6. If you selected Advanced Setting, in the second Entry Point Format box, type W,
C, or X as the Calling Party.

7. In the Call Flow list, select a call flow.

8. Click Add.

9. Click Change Position to change the order of the configured entry points.
Ensure that the W_W entry point is the last entry in the entry points table.

Job aid

The following table identifies call flows that are available to configure an entry point.
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Table 4: Available call flows

Call flow Description
BUSY/NOANSWER Used when a call is not answered. The caller

can leave a message or be transferred to the
operator.
For a Busy/NoAnswer call flow, the only entry
point required is W_W. This format is
automatically added and must be the last
item in the list.

DIRECT Access a user mailbox to retrieve message
or modify mailbox options.

SETAWU A guest or operator can configure an Auto
Wake-Up call.

XPRESS MESSAGE LEAVE Leave a message without calling a user.
Note: All messages left this way will
have ’Hotel Staff’ as the Call Sender ID.

XPRESS MESSAGE RETRIEVE Retrieve a message from any phone on the
system.

POST CO RETRIEVE Retrieve messages for hotel guests that
checked out recently.

MINIBAR/Room Status Update the hotel PMS with charges for items
guests consumed from the minibar and with
guest room status.

TUI Access the Telephone User Interface (TUI)
to complete administrative transactions over
the telephone.

CALLFLOW.AA Access various Auto Attendant call flows.

The following table identifies the options available for the Calling Party.

Table 5: Calling party options

Calling party option Description
W A wildcard that represents any length for the

Called or Calling Party. The wildcard option
can be used for any call flow and is the default
option.

C Use this option if the Called Party information
is required. This option is used for the
DIRECT and SETAWU call flows.
This option is available only if you selected
Advanced Setting.
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Calling party option Description
X Use this option to ignore the Calling Party

information. This option is used for TUI, AA,
MINIBAR, ROOMSTATUS, XPRESS
MESSAGE, and SETAWU call flows.
This option is available only if you selected
Advanced Setting.

Configuring the PMS setting
About this task
Configure the Property Management System (PMS) settings for the Hotel PMS interface.

 Important:
Obtain the required information from the Hotel PMS representative and configure only the
options specified.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, select PMS Setting.

3. In the PMS Setting window, in the IP Setting section, click Edit to configure the
required options.

4. Type the required values for PMS IP and Port No.
For PMS IP, type the ELAN IP address.

5. Click Update to save your changes.

6. In the PMS Setting section, for the PMS Type select either CS1000 or Intuity
Lodging .

Variable Definitions

Variable Value
PMS IP The PMS IP (ELAN) address.

Port No. The PMS port number.

PMS Type Select either CS1000 or Intuity Lodging .
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Configuring Communication Server 1000 settings
About this task
Configure Communication Server 1000 (CS 1000) settings to enable communication between
the HMS 400 and CS 1000.

 Important:
Obtain the required information from the Hotel PBX representative and configure only the
options specified.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, select PBX Setting.

3. In the Comm Setting, in the IP Setting section, click Edit to configure the required
options.

• In the PBX IP (ELAN) box, type the ELAN IP address.

4. Click Update to save your changes.

Variable Definitions

Variable Value
PBX IP (ELAN) The PMS IP address.

PBX PMS Login Name The PBX PTY user name.

Password The PBX PTY password.

Configuring HMS 400 server settings
About this task
Configure the HMS 400 server IP address and SNMP setting in the HMS 400 Server Settings
section. Unless the IP address changes, you configure the HMS 400 server IP address only
once. If the IP address changes, you must reconfigure the HMS 400 IP address setting. After
you configure the SNMP settings, a third-party SNMP manager system can capture HMS 400
SNMP notifications.
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Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, click HMS400 Server Setting.

3. In the HMS400 Server Setting window, in the HMS400 TCP/IP Setting section,
click Edit.

4. In the New HMS400 IP box, type the HMS 400 IP (TLAN) address.

5. Click Update to save your changes, or click Cancel to discard your changes.

6. In the SNMP Setting section, click Edit.

7. In the New SNMP Manager IP box, type the SNMP Manager IP address.

8. (Optional) In the Port No box, type the SNMP port number if it is required.

9. Click Update to save your changes, or click Cancel to discard your changes.

Configuring the SIP Setting
About this task
Configure the SIP setting.

Prerequisites:

• The SIP Server IP is the CS 1000 TLAN Node IP address.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, click SIP Setting.

3. To change the Node IP address or the NRS IP address/Domain Name, in the SIP
Setting section, in the CS 1000 Node IP/CM IP box, type the new CS 1000 Node/
NRS IP address or NRS Domain Name.
The current CS 1000 Node IP/CM IP field displays the current CS 100 Node/NRS
IP address or NRS Domain Name.

4. For Transport Protocol, select TCP or UDP.

5. In HMS Pilot Number, type in the extension number.

6. In New HMS 400 IP (TLAN), type the HMS 400 server IP address.

7. Click Update to save your changes.
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Variable Definitions

Variable Value
Current CS 1000 Node/NRS IP; NRS
Domain; CM IP

The current CS 1000 Node/NRS IP address
or NRS Domain or CM IP address

New CS 1000 Node/NRS IP; NRS Domain;
CM IP

The new CS 1000 Node/NRS IP address or
NRS Domain or CM IP address

Transport Protocol The protocols used for packet transfer.

• TCP—Transmission Control Protocol

• UDP—User Datagram Protocol

) The Transport Protocol follows the CS 1000
or Communication Manager setting.

HMS Pilot Number The number for the hotel to call into the HMS
400 server.

Current HMS 400 IP (TLAN) The current HMS 400 IP address.

New HMS 400 IP (TLAN) The new HMS 400 IP address.

Configuring Log Printer Setting
About this task
Configure the Log Printer setting to specify the printer that transactions are sent to for printing.
HMS 400 supports up to three printers and a printer can be either Local or Networked.

Prerequisites:

• You must configure printers separately and they must be recognized by the operating
system before you can select the printer in the Log Printer Setting section.

• You can configure printers for the following options:
- AWU
- Minibar
- Room Status

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, click Log Printer Setting.

3. To configure a printer for AWU Printer, Minibar Printer, or Room Status Printer:
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• For a local printer, select the printer that you want to send print requests to.

• For a network printer, type the URL of the network printer.
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Chapter 9: Avaya Hospitality Messaging
Server 400 system settings
commissioning

About this task
This chapter describes how to commission the Avaya HMS 400 system settings.

Navigation:

• Configuring Outcall Attempts on page 71
• Configuring default check in language on page 73
• Configuring Message Housekeep on page 74
• Configuring room change requirements on page 75
• Configuring TUI settings on page 76
• Configuring Guest Mailbox PIN options on page 77
• Configuring AWU setting on page 78
• Configuring Minibar setting on page 80
• Configuring Room Status setting on page 83
• Configuring Operator setting on page 84
• Configuring VPIM settings on page 85
• Editing the VPIM Setting - HMS 400 (Local) on page 86
• Editing the VPIM settings – CallPilot / HMS 400 on page 87
• Configuring Language Mapping on page 87
• Configuring Remote Message Notification Setting on page 88

Configuring Outcall Attempts
About this task
Configure the number of attempts or retries the HMS 400 system makes for a Remote Message
Notification outgoing call when the initial attempt fails.
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Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the System Settings section, click Pg
1 beside General Setting.

3. In the Outcall Attempts section, click Edit.

4. In the Maximum Attempts box, type the required number of attempts.

5. Click Update to save your changes or click Cancel to discard your changes.

Variable Definitions

Variable Value
Maximum Attempts The number of attempts or retries the HMS

400 system makes for a Remote Message
Notification outgoing call when the initial
attempt fails.
The range is 1 to 99 attempts.

Configuring ring duration
About this task
Configure the number of seconds for an automatic wake up (AWU) call or remote notification
call to ring before the system considers it to be unanswered.

Prerequisites:

 Important:
The Call Forward No Answer (CFNA) duration on the CS 1000 must be longer than the
number of seconds assigned for the AWU ring duration. IThe default CFNA value is five
rings, which translates to approximately 20 seconds. Therefore, configure the AWU ring
duration to a lower value, such as 15 seconds; otherwise, unintended results for the wake
up call can occur.

Procedure

1. Start HMS 400 and log on as an administrator.

2. On the menu bar, click System Configuration.
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3. In the left pane, in the System Settings section, to the right of General Setting,
click Pg 1.

4. In the right pane, in the Ring Duration section, click Edit.

5. From the AWU list, select the required number of seconds.

6. From the RMN list, select the required number of seconds.

7. Click Update to save the changes.
OR
Click Cancel to discard the changes.

8. Restart HMS 400 for the changes to take effect.

Variable Definitions

Variable Value
AWU list Select the number of seconds for an

automatic wake up call to ring before the
system considers the call unanswered.

RMN list Select the number of seconds for remote
notification call to ring before the system
considers the call unanswered.

Configuring default check in language
About this task
When a customer checks into the hotel, the hotel PMS normally configures the preferred
language for that customer. If the preferred language information is not provided, the HMS 400
system uses the Default Check In Language that you configure in the following procedure.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the System Settings section, click Pg
1 beside General Setting.

3. In the Default Check In Language section, click Edit.

4. In the Language list, select the default language.
Only installed languages are available.

Configuring default check in language
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5. Click Update to save your changes, or click Cancel to discard your changes.

Configuring Message Housekeep
About this task
Deleted messages for the administrator, current guests, and guests who checked out are
retained for a configurable number of days before the messages are permanently removed
from the system. A guest who has checked out can retrieve messages with operator
assistance.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the System Settings section, click Pg
2 beside General Setting.

3. In the Message Housekeep section, click Edit.

4. In the Admin box, type the maximum number of days that deleted messages are
retained before being permanently deleted.

5. In the Guest box, type the maximum number of days that deleted messages are
retained before being permanently deleted.

6. In the Check Out Guest box, type the maximum number of days that deleted
messages are retained before being permanently deleted.

7. Click Update to save your changes, or click Cancel to discard your changes.

Variable Definitions

Variable Value
Admin The maximum number of days messages,

deleted by the administrator, are retained
before being permanently deleted.
The range is 1 to 99 days. The default is 2.

Guest The maximum number of days messages
deleted by a current guest are retained
before being permanently deleted.
The range is 1 to 99 days. The default is 2.
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Variable Value
Check Out Guest The maximum number of days messages

remain in a checked out guests mailbox
before being permanently deleted.
The range is 1 to 99 days. The default is 3.

Configuring room change requirements
About this task
Configure a timer (in seconds) to recognize the difference between a guest room change and
a guest check out. The room change timer computes the time between receiving a check out
record and a check in record for a guest. If the period is within the configured time frame, the
system completes a room change and moves all the pertaining records to the new room.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the System Settings section, click Pg
3 beside General Setting.

3. In the Room Change Requirements section, click Edit.

4. In the Room Change Interval box, type a value for the room change interval in
seconds.

5. Click Update to save your changes, or click Cancel to discard your changes.

Variable Definitions

Variable Value
Room Change Interval The time interval between a guest check out

and check in that determines if the guest
changed rooms instead of checking out.
The default is 20 seconds. The range is 1 to
999 seconds.

Configuring room change requirements
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Configuring TUI settings
About this task
Configure the default guest name and the PIN for any guest that is checked in using the TUI.
An administrator can check a guest in using the Telephone User Interface (TUI). The default
guest name is the new guest unless otherwise specified. You can base the PIN on the Room
No. or Check In Date.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, in the System Settings section, click Pg
3 beside General Setting.

3. In the TUI Setting section, click Edit.

4. In the Guest Name box, type the default guest name or select the Use default
name check box to use the default name.

5. In the PIN list, select the default PIN settings for the guest.

6. If you selected Follow Check In Date in the PIN list, select the PIN format in the
Date Format list.

7. Click Update to save your changes, or click Cancel to discard your changes.

Variable Definitions

Variable Value
Guest Name The default guest name used for guests

checked in using the TUI.
The default name is New Guest.

PIN The default PIN number for guests checked
in using the TUI.

• 1 - Follow Room No—the PIN is the same
as the room number.

• 2 - Follow Check In Date—the PIN is the
check in date.
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Variable Value
Date Format The date format if Follow Check In Date is

selected in the PIN list. The options available
are:

• mmdd—the PIN is the current month
followed by the date.

• ddmm—the PIN is the current date
followed by the month.

Configuring Guest Mailbox PIN options
About this task
Configure the guest mailbox PIN format. Every guest requires a PIN to access their mailbox
outside of their rooms. Guest PINs are automatically created when a guest checks in.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the System Settings Section, click
Pg 3 beside General Setting.

3. In the Guest Mailbox PIN Options section, click Edit.

4. In the PIN list, select the PIN format.

5. If you selected Default as Check In Date in the PIN list, select the PIN format in
the Date Format list.

6. If you selected Default As Info From PMS in the PIN list, in the PIN Position box
type a value for the PIN position and in the Pin Length box, type a value for the
PIN length.

7. If you selected Default as Guest Name in the PIN list, select the required language
in the Language list and type a value for the PIN length in the PIN Length box.

8. Click Update to save your changes or click Cancel to discard your changes.

Variable Definitions

Variable Value
PIN The guest mailbox PIN format options.

Configuring Guest Mailbox PIN options
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Variable Value

• 1 - Default As Room No

• 2 - Default As Check In Date

• 3 - Default As Info From PMS

• 4 - Default As Guest Name

Date Format The date format for the PIN.

• mmdd—the PIN is the current month
followed by the date.

• ddmm—the PIN is the current date
followed by the month.

PIN Position The digit entered in this field indicates the
start position for the extraction of the PIN
from the Name field of a Check In packet.
The range is 1 to 99.

PIN Length The number of digits for the PIN.
The range is 1 to 8.

Language The preferred language for the guest.

Configuring AWU setting
About this task
Configure the Auto Wake-Up (AWU) settings.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
AWU Setting.

3. On the AWU Setting page, in the Max Attempts box, type a value for the maximum
number of attempts that a wake-up call is made to a guest room the guest does not
answer or if the line is busy.

4. In the Next Call box, type a value for the interval (in minutes) between AWU
attempts.

5. In the Printer Logging list, select the print logging option required.

6. In the AWU Operator box, type the AWU operator extension number to call when
AWU calls are unanswered after the maximum number of attempts is reached.
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7. In the Reactivate DND list, select either Yes to reactivate DND after AWU is called
or No to deactivate DND after AWU is called.

 Note:
The “Deactivate DND” option is not applicable to HMS 400 systems integrated
with Communication Manager.

8. Click Save to save your changes.

Variable Definitions

Variable Value
Max Attempts The maximum number of attempts that a

wake-up call is made to a guest room if there
is no answer or the line is busy. The number
of attempts includes the original call. When
the maximum number of attempts is
reached, the AWU operator is notified of the
wake-up call failure.
The default is 3. The range is 1 to 99.

Next Call The interval in minutes between each AWU
attempt.
The default is 2 minutes. The range is 1 to
99.

Printer Logging Specify the AWU log transactions to print.
The options available are:

• Disable Print—disables AWU printing.

• Print Answered Call (Set/Cancel/Operator)
—prints successful AWU calls including
snooze, set, cancel, and transfer to
operator attempts.

• Print Busy/No Answer Call (Set/Cancel/
Fail/Operator)—prints rescheduled
(unanswered/busy) calls including set,
cancel, fail, and transfer to operator
attempts.

• Print Fail (Set/Cancel/Fail/Operator)—
prints calls made to the AWU operator
including set, cancel, fail, and transfer to
operator attempts.
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Variable Value

• Print Failed wake up calls only—prints only
failed wake up calls.

• Print All—prints all AWU call transactions.

AWU Operator The extension number of the AWU operator.
The AWU operator is notified when an AWU
call is unanswered after the maximum
number of attempts is reached. When the
AWU operator is notified, the room number
is announced so that the operator can take
appropriate action.
The default extension is 0.

Reactivate DND . Select Yes to reactivate DND after AWU is
called or No to deactivate DND after AWU is
called.

Configuring Minibar setting
About this task
Configure all minibar-related settings in the Minibar Setting section.

 Important:
There is no support in the Intuity Lodging Interface to send minibar inventory information to
the Property Management System, so this feature is unavailable on Communication
Manager-integrated versions of HMS 400. Fewer voicemail ports are required on
Communication Manager-integrated versions of HMS 400 because the minibar inventory
feature cannot be used.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
Minibar Setting.

3. On the Minibar Setting page, in the Minibar Posting to PMS list, select Yes to
send all minibar posting to the Hotel PMS or select No to disable postings.

4. In the Log Printing list, select Yes to permit log printing for minibar transactions or
select No to disable log printing for minibar transactions.

5. In the Posting Type list, select Total (Lump Sum) or Itemized.

6. If you want to configure tax options, select the desired options for Tax 1, Tax 2, and
Tax 3.
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 Important:
By default, tax options are disabled and taxation is handled by the Hotel PMS.
You can configure up to three tax options.

7. Click Save to save your changes.

Variable Definitions

Variable Value
Minibar Posting to PMS Defines minibar posting options.

• Yes—send all minibar postings to the Hotel
PMS. The type of packet sent depends on
the options selected for Posting Type.

• No—disable all minibar postings.

Log Printing Enables or disables log printing for minibar
transactions.

• Yes—enable log printing for minibar
transactions.

• No—disable log printing for minibar
transactions.

Posting Type Defines how information about items
purchased from the minibar is reported to the
Hotel PMS.

• Total (Lump Sum)—all postings for the
room are added up and sent as one record
with a grand total to the Hotel PMS.

• Itemized—one record for each item
entered by housekeeping is sent to the
Hotel PMS. Each record contains the room
number, quantity, item code, item price,
and applicable taxes.

Tax 1 The following tax options that charge tax
based on a specified percentage are
available.

• Category—Configure options for Food,
Beverage, and Others.

• Government Tax

• Surcharge
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Variable Value

• Value Added Tax

• None

You can configure each tax option only
once.

Tax 2 Tax 2 has four Tax options only available
(excluding the selected option in Tax 1).

Tax 3 Tax 3 has three Tax options only available
(excluding the selected option in Tax 1 and
Tax 2).

Food Available if you selected the Category tax
option
When you create minibar items, each item is
assigned a category of Food, Beverage, or
Other. Specify the amount, as a percent of
the item price, to charge as a tax for Food
items.

Beverage Available if you selected the Category tax
option.
When you create minibar items, each item is
assigned a category of Food, Beverage, or
Other. Specify the amount, as a percent of
the item price, to charge as a tax for
Beverage items.

Others Available if you selected the Category tax
option.
When you create minibar items, each item is
assigned a category of Food, Beverage, or
Other. Specify the amount, as a percent of
the item price, to charge as a tax for Other
items.

Tax Method Available if you selected the Government,
Surcharge, or Value Added Tax option.

• Basic only—imposes tax based on the
basic amount.

• Basic + Tax—imposes tax based on the
amount after previous taxes are added.

Surcharge Available if you selected the Surcharge tax
option.
Defines the amount of surcharge tax to add
as a percentage of the item price.

Value Added Tax Available if you selected the Value Added
Tax option.
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Variable Value
Defines the amount of value added tax to add
as a percentage of the item price.

Government Tax Available if you selected the Government Tax
option.
Defines the amount of government tax to add
as a percentage of the item price.

Configuring Room Status setting
About this task
Enable or disable log printing for the room status transactions.

Prerequisites:

• To print room status transactions, you must assign a printer for the Room Status Setting. For
more information, see Configuring Log Printer Setting on page 68.

 Important:
The Intuity Lodging voicemail interface does not support sending room/maid status codes
to the Property Management System; therefore, the room/maid status feature available on
the HMS 400 with CS 1000 are not available for Communication Manager. Communication
Manager customers must continue to use the Communication Manager maid status
feature.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
Room Status Setting.

3. On the Room Status Setting page, in the Log Printing list, select Yes to enable
log printing for room status transactions or select No to disable log printing for room
status transactions.

4. Click Save to save your changes.

Configuring Room Status setting
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Configuring Operator setting
About this task
Configure the Operator Setting to define the operator extension number and message desk
retrieval extension.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
Operator Setting.

3. On the Operator Setting page, in the Operator box, type the Operator ACD queue
DN or extension number of a specific attendant.

4. In the Message Desk box, type the extension number used for guest text message
retrieval.

5. Click Save to save your changes.

Variable Definitions

Variable Value
Operator The operator ACD queue DN or extension

number of a specific attendant. The
maximum length is 10 digits.

Message Desk Used to facilitate guest text message
retrieval. The hotel staff member who
attends this extension number reads
messages left for the guest. The maximum
length is 10 digits.
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Configuring VPIM settings
About this task
Using the VPIM protocol, HMS 400 can exchange messages with a Call Pilot or another HMS
400 system on the same network. Configure the VPIM settings to permit the HMS 400 to
communicate with other systems.

 Important:
You cannot send messages using Outlook Express to HMS 400 as it does not conform to
VPIM Protocol.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
VPIM Setting.

3. On the VPIM Setting page,under the Configuration for HMS (Local) section, in
the PSTN box, type the PSTN number for HMS 400.

4. In the Domain box, type the HMS 400 domain name.

5. In the VCard Directory box, type the folder name of the VPIM Card.

6. In the FQDN Authorization box, select True or False.

7. Click Save to save your changes.

8. In the Configuration for CallPilot/HMS section, in the Prefix box, type the prefix
number for the VPIM shortcut.

9. In the PSTN box, type the PSTN number to where to send a message.

10. In the Domain box, type the VPIM domain name.

11. Click Save to save your changes.
The prefix number is compared to existing extension numbers in the database. If
you enter a prefix number that is the same as an existing number, an error occurs
and you must change the prefix value.
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Variable definitions

Variable Value
Configuration for HMS (Local)section

PSTN The telephone number for HMS 400. The
maximum length is 20 digits.

Domain HMS 400 domain name.

VCard Directory VPIM card folder name. The default is
VPIMVCARD.

FQDN Authorization Authorization for adding the HMS 400
domain name to userid. This depends on the
configuration of CallPilot.

• True – allows HMS 400 domain name to be
added to user id.

• False – does not allow HMS 400 domain
name to be added to user id.

Configuration for CallPilot/HMSsection

Prefix The Prefix of the VPIM shortcut that indicates
to the HMS 400 that the following message
is to be sent to a VPIM recipient. The
maximum length is 10 digits.

PSTN The telephone number for VPIM. The
maximum length is 20 digits.

Domain The VPIM domain name.

Editing the VPIM Setting - HMS 400 (Local)
About this task
Edit the VPIM setting of the HMS 400 to change an existing VPIM configuration on the HMS
400.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
VPIM Setting.
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3. On the VPIM Setting page, under the Configuration for HMS (Local) section, click
Edit.

4. Modify the Prefix, PSTN, Domain, VCard Directory, and FQDN Authorization,
as required.

5. Click Update to save your changes, or click Cancel to cancel the changes.

Editing the VPIM settings – CallPilot / HMS 400
About this task
You can edit the VPIM Setting to change an existing VPIM Shortcut configuration.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
VPIM Setting.

3. On the VPIM Setting page, in the list of configured CallPilot and HMS, click Select
beside the shortcut to edit.

4. Modify the Prefix, PSTN, and Domain options as required.

5. Click Update to save your changes, or click Delete to delete the VPIM Shortcut

Configuring Language Mapping
About this task
Configure Language Mapping options to ensure that hotel guests hear prompts in the language
of their choice.

Prerequisites:

• Obtain information about the Hotel PMS supported languages. Hotel PMSs have different
ways of representing language codes. You must identify the language codes for your Hotel
PMS.

Procedure

1. On the Web Configuration main navigation bar, select System Configuration.

Editing the VPIM settings – CallPilot / HMS 400
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2. In the System Configuration navigation, in the System Settings section, click
Language Mapping.

3. On the Language Mapping page, in the Language list, select the supported
language.

4. In the PMS Code box, type the PMS code for that language.

5. Click Add.

6. To edit the Language Mapping, click Edit beside the mapping you want to edit.

7. To delete a Language Mapping, click Delete beside the mapping you want to
delete.

Configuring Remote Message Notification Setting
About this task
The Administrator can configure the system to call a pre-defined external number to notify the
user of a new voice message. Users can do these steps themselves if access is granted
through their individual Mailbox Web page. Up to three numbers can be set per mailbox.

Prerequisites:

• Obtain the external call prefix number(s), pause duration (if necessary), and the remote
notification numbers from the customer.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the System Settings section, click
Remote Message Notification Setting.

3. On the Remote Message Notification Setting page, in the Mailbox ID box, key
in the ID.

4. Click Search.

5. In the Enable Notification box, select YES.

6. In the Phone#1 box, type the extension number (internal DN) OR The external
prefix followed by "," then the phone number (external).

7. Click the check boxes beside Phone#2 and Phone#3 accordingly in order to key
in the next numbers.

8. Click Save to save your changes.
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Variable Definitions

Variable Value
Enable Notification Defines RMN options. The options available

are:

• YES - Enable RMN

• NO - Disable RMN

Extension numbers Valid Internal extension number (no).

External Prefix The number(s) to dial before attempting an
external call.

"," Indicates pause.
Recommended maximum number of ","
(pauses) can be used is two.

Maximum digits A maximum of 26 digits can be entered in
Phone#1, Phone#2, and Phone#3 boxes.

Configuring Remote Message Notification Setting
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Chapter 10: Commissioning the Avaya
Hospitality Messaging Server
400 database

About this task
Configure Avaya HMS 400 database options such as staff extension numbers, mailbox numbers, guest
rooms, and guest extensions to ensure the HMS 400 can recognize each extension and room in the hotel
as a valid configuration to prevent service disruption.

• Configuring a guest room on page 91
• Adding extensions to a Guest Room on page 93
• Configuring a single mailbox single extension Admin Mailbox on page 94
• Configuring a multiple mailbox single extension Admin Mailbox on page 95
• Configuring a single mailbox multiple extension Admin Mailbox on page 97
• Adding an extension to an Admin Mailbox on page 99
• Adding a mailbox to an Admin Mailbox on page 99
• Viewing or deleting an extension on page 100
• Creating users on page 101
• Editing user details on page 103
• Configuring Admin Classes of Service on page 103
• Configuring Guest Classes of Service on page 106
• Configuring an introductory message on page 109

Configuring a guest room
About this task
Configure a guest room to configure the CoS, number of rooms and number of extensions.

Prerequisites:

• Obtain a hotel room listing.
• For information about configuring a guest Class of Service (CoS), see Configuring Guest

Classes of Service on page 106.
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Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
Guest Room Setup Pg 1.

3. On the Guest Room Setup page, in the No. of Rooms box, type the number of
rooms to create for a guest if the room numbers are sequential.
OR
In the No. of Rooms box, type 1, and in the Room No. box, type the room
number.

4. In the COS list, select the class of service for the guest.

5. In the Extension 1 box, type the extension number for the guest.
If you configure more than one room, succeeding extensions numbers are
automatically assigned to the remaining rooms.

6. If each room has more than one line, select the check box beside each additional
Extension and type the extension number in the Extension box.

7. Click Create to generate the guest room record.

8. Click Update to save the guest room record.

Variable Definitions

Variable Value
No. of Rooms The number of rooms to create for a guest.

The default is 1.

Room No. The guest room number.

COS The class of service for the guest. This option
determines the type of features and functions
available to guest. The default is 0 - Default
COS FOR Non VIP Guest.

Extension The guest extension number. If you configure
more than one room, succeeding extensions
numbers are automatically assigned. The
maximum number of extensions is 10.
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Adding extensions to a Guest Room
About this task
Perform this procedure to add extension number(s) to a guest room that has been
configured.

Prerequisites:

• Ensure that the extension numbers are not in use or taken.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
Guest Room Setup Pg 2.

3. On the Guest Room Setup Pg 2, in the Mailbox ID box, type the Mailbox of an
existing room.

4. Click Display Mailbox to view the Room No, Extension No, Mailbox ID,
Extension type, and Status.

5. In the Extension box, type the extension number.

6. Click Save to save your changes.

Variable Definitions

Variable Value
Mailbox ID Mailbox number of an existing room

(generally, mailbox no = room number)

Extension A valid new extension number

Adding extensions to a Guest Room
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Configuring a single mailbox single extension Admin
Mailbox

About this task
Configure an Admin Mailbox with one mailbox for each extension number to allow staff to
access the voice mail services.

Prerequisites:

• You must create an extension for every staff member, even if the staff member does not
have mailbox access for call transfer scenarios.

• For information about configuring Admin class of service, see Configuring Admin Classes
of Service on page 103.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
Admin Mailbox Setup Pg 1.

3. On the Admin Mailbox Setup page, in the No. of Extns box, type the maximum
number of extensions if the Admin extensions are sequential.
If the Admin extensions are not sequential, type 1.

4. In the Extn Type list, select the extension type.

5. In the COS list, select the class of service.

6. In the Language list, select the required language for the mailbox.

7. In the Extension 1 box, type the starting extension number for the range of
mailboxes.

8. Click Create to create the mailbox entries.

9. To modify the mailbox name, from the list, select the mailbox.

10. At the bottom of the page, in the box, type a name for the mailbox.
You can type a first and last name.

11. Click Add.

12. Click Update to save the data.

Commissioning the Avaya Hospitality Messaging Server 400 database

94     Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Hospitality Messaging Server 400 Installation and Commissioning


Variable Definitions

Variable Value
No. of Extns The number of extensions to configure.

The default is 1.

Extn Type The extension type. The options available
are:

• Mailbox—a valid extension with an active
mailbox.

• Extn—a valid extension without a mailbox.
This is used for call transfer situations.

• Phantom—a virtual extension with an
active mailbox. Message waiting lamp
(MWL) control now exists.

COS The class of service (CoS) that determines
the characteristics and behavior of the
mailbox. The default is 1 - General Staff. You
can configure up to 40 CoS.

Language The language of the mailbox.

Extension 1 The starting extension number for the range
of mailboxes.

Configuring a multiple mailbox single extension Admin
Mailbox

About this task
Perform this procedure to create and assign up to five mailboxes to an extension number. If
you configure this option, the system prompts the user to select the mailbox to leave a voice
mail for.

Prerequisites:

• Confirm the mailbox numbers available. Mailbox numbers are usually the same as the
extension numbers.

• Determine which extensions exist to help allocate the correct numbers and prevent
duplication errors.

Configuring a multiple mailbox single extension Admin Mailbox
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Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
Admin Mailbox Setup Pg 1.

3. On the Admin Mailbox Setup page, select the Multiple Mailbox Single Extension
check box.

4. In the Extension box, type the extension number for the mailbox.

5. In the Extn Type list, select the extension type.

6. In the COS list, select the class of service.

7. In the Language list, select the required language for the mailbox.

8. In the MailboxID1 box, type the mailbox identification number for mailbox 1.

9. To configure a second mailbox, select the check box beside MailboxID2 and type
the mailbox identification number for mailbox 2.

10. To configure a third mailbox, select the check box beside MailboxID3 and type the
mailbox identification number for mailbox 3.

11. To configure a fourth mailbox, select the check box beside MailboxID4 and type
the mailbox identification number for mailbox 4.

12. To configure a fifth mailbox, select the check box beside MailboxID5 and type the
mailbox identification number for mailbox 5.

13. Click Create to create the entries.

14. To modify the name of one of the mailboxes, from the list, select the mailbox.

15. At the bottom of the page, in the box, type a name for the mailbox.
You can type a first and last name.

16. Click Add.

17. To modify the names of additional mailboxes, repeat steps 14 on page 96 to 16 on
page 96.

18. Click Update to save the data.

Variable Definitions

Variable Value
Extension The mailbox extension number.

Extn Type The extension type.
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Variable Value

• Mailbox—a valid extension with an active
mailbox.

• Extn—a valid extension without a mailbox.
This is used for call transfer situations.

• Phantom—a virtual extension with an
active mailbox. Message waiting lamp
(MWL) control now exists.

COS The class of service (CoS) that determines
the characteristics and behavior of the
mailbox. The default is 1 - General Staff. You
can configure up to 40 CoS.

Language The language of the mailbox.

MailboxID The mailbox identification number.

Configuring a single mailbox multiple extension Admin
Mailbox

About this task
Perform this procedure to create one mailbox that is shared by up to five extensions. A voice
mail left for any of the configured extensions is saved in the assigned mailbox.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
Admin Mailbox Setup Pg 1.

3. On the Admin Mailbox Setup page, in the No. of Extns box, type 1.

 Important:
If you configure more than one extension, the extension numbers must be at least
two numbers apart; they cannot be sequential.

4. In the Extn Type list, select Mailbox.

5. In the COS list, select the class of service.

6. In the Language list, select the required language for the mailbox.

7. In the Extension 1 box, type the first extension number.

8. To configure a second extension, select the check box beside Extension2 and type
the second extension number in the Extension2 box.

Configuring a single mailbox multiple extension Admin Mailbox
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9. To configure a third extension, select the check box beside Extension3 and type
the third extension number in the Extension3 box.

10. To configure a fourth extension, select the check box beside Extension4 and type
the fourth extension number in the Extension4 box.

11. To configure a fifth extension, select the check box beside Extension5 and type the
fifth extension number in the Extension5 box.

12. Click Create to create the entries.

13. To modify the mailbox name, from the list, select the mailbox.

14. At the bottom of the page, in the box, type a name.
You can type a first and last name.

15. Click Add.

16. Click Update to save the data.

Variable Definitions

Variable Value
No. of Extns The number of extensions to configure.

Extn Type The extension type.

• Mailbox—a valid extension with an active
mailbox.

• Extn—a valid extension without a mailbox.
This is used for call transfer situations.

• Phantom—a virtual extension with an
active mailbox. Message waiting lamp
(MWL) control now exists.

COS The class of service (CoS) that determines
the characteristics and behavior of the
mailbox. The default is 1 - General Staff. You
can configure up to 40 CoS.

Language The language of the mailbox.

Extension The extension number for the mailbox.

Commissioning the Avaya Hospitality Messaging Server 400 database

98     Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Hospitality Messaging Server 400 Installation and Commissioning


Adding an extension to an Admin Mailbox
About this task
Perform this procedure to add an extension to an Admin Mailbox that has already been
configured.

Prerequisites:

Ensure that the extension numbers entered are not in use or taken. You may also want to check
the existing number to which additions are to be made by going to the View/Delete page.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
Admin Mailbox Setup Pg 2.

3. On the Admin Mailbox Setup Pg 2, select the Add Extension option.

4. In the Mailbox ID box, type the ID.

5. Click Display to view the details of the Mailbox ID.

6. In the Extension box, type the new extension number.

7. Click Add to save your changes.

Variable Definitions

Variable Value
Extension A valid new extension number

Adding a mailbox to an Admin Mailbox
About this task
Perform this procedure to add a mailbox to an Admin Mailbox that has already been
configured.

Prerequisites:

Adding an extension to an Admin Mailbox
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Ensure that the mailbox numbers entered are not in use or taken. You may also want to check
the existing mailbox number to which additions are to be made by going to the View/Delete
page.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
Admin Mailbox Setup Pg 2.

3. On the Admin Mailbox Setup Pg 2, select the Add Mailbox option.

4. In the Extension box, type the extension number.

5. Click Display to view the details of the extension.

6. In the Mailbox ID box, key in the new ID

7. Click Add to save your changes.

Variable Definitions

Variable Value
Mailbox ID A valid new Mailbox ID

Viewing or deleting an extension
About this task
Perform this procedure to view a list of the extensions or rooms in use or to delete an extension
or room. You cannot delete a room that is still occupied.

Prerequisites:

• Admin extensions do not have a room number. The room number field is NULL.
• If more than one page of extension numbers is available, the number of pages appears

at the bottom of the View/Delete Extension page. Select a page number to go to that page
or click the ellipses (...) to view additional page numbers.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the Database Setup section, click
View/Delete Extension.

Commissioning the Avaya Hospitality Messaging Server 400 database

100     Avaya Hospitality Messaging Server 400 Installation and Commissioning March 2012
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Avaya Hospitality Messaging Server 400 Installation and Commissioning


3. On the View/Delete Extension page, all extension numbers appear by default.

4. To view only guest extensions, select Guest and click Display.

5. To view only admin extensions, select Admin and click Display.

6. To view a specific extension using a room number, select All, type the room number
in the Room No box and click Display.

7. To view a specific extension using an extension number, select All, type the
extension number in the Extension No box, and click Display.

8. To delete an extension, select the check box beside each extension to delete.

 Important:
Ensure mailboxes are not in use before you delete them.

9. Click Delete.

10. In the confirmation window, click Yes to delete the extension or Cancel to cancel
the request.

Creating users
About this task
An administrator can create users with specific access rights for specific purposes. Current
users appear at the bottom of the page.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the User Setup section, click Create
User.

3. On the Create User page, in the User ID box, type the user ID.

4. In the User Name box, type the user name.

5. In the Password box, type the user password.

6. In the Confirm Password box, retype the password.

7. In the Password Retention box, type the number of days that the user password
is active before it expires.

8. In the Access Rights section, select the user access rights.

 Important:
Avaya recommends that you enable the System Configuration Access Rights for
only the administrator.

Creating users
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9. Click Create User to create the user or click Clear to discard your changes.

Variable Definitions

Variable Value
User ID The user identification name. The following

rules apply to user IDs:

• Must be at least four alphanumeric
characters in length.

• User ID is case-sensitive.

• Spaces and symbols are not valid.

User Name The user name.

Password The user password. The password must be
six to eight characters in length and must
contain at least one number and one letter.
The password is case-sensitive.

Confirm Password Password confirmation.

Password Retention Password Retention determines how long
the system keeps a user password active
before it expires. The range is 1 to 120
days.
If a user does not change the user password
it expires, the user cannot access the Web
module until the administrator creates a new
password. Users are reminded that their
password will expire seven days prior to the
expiry date and every day after that until the
expiry date is reached.
For information about changing the user
password, see Changing the password on
page 61.

Access Rights You can enable the following access rights
for a user:

• System Configuration

• Hotel Operation—If you select Hotel
Operation, the following options are
enabled: Manual Posting, Hotel
Employees, Room Status, Minibar, AWU,
Auto Attendant.

• Administration
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Variable Value

• Utilities

• Reports

Editing user details
About this task
You can edit the user details.

Prerequisites:

• You must create at least one user. For more information, see Creating users on page 101.

Procedure

1. On the Web Configuration main navigation bar, click System Configuration.

2. In the System Configuration navigation, in the User Setup section, click Create
User.

3. On the bottom of the Create User page, click Edit beside the user to edit.

4. On the Edit User page, modify the user details as necessary.

5. Click Save to save your changes, or click Cancel to discard your changes.

Configuring Admin Classes of Service
About this task
You can configure up to 40 Admin Classes of Service (CoS).

Prerequisites:

• Two CoS are created by default. You can use the default CoS or create new ones.
- 1 General Staff
- 2 Executive Staff

Procedure

1. On the Web Configuration main navigation bar, click Administration.

2. In the Administration navigation, in the Mailbox Maintenance section, click
Admin COS Configuration.

Editing user details
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3. On the Admin Class of Service Configuration page, in the COS No list, select
the CoS number to configure.
You can select an existing CoS or select number. You need not select numbers in
sequence.

4. In the Name box, type a meaningful name for the CoS.

5. In the Maximum Message(s) to Keep box, type the total number of new and old
messages to keep.

6. In the Maximum Message Length box, type the maximum message length in
seconds.

7. In the Number of Day(s) to Store New Messages box, type the number of days
to store new messages.

8. In the Number of Day(s) to Store Old Messages box, type the number of days to
store old messages.

9. In the Allow Message Broadcast list, select YES to permit sending messages
using a distribution list, or select NO to disable sending messages using a
distribution list.

10. In the Personal Identification Announcement list, select NAME or NUMBER as
the announcement type.

11. In the Anonymity Mode list, select YES to disable announcing the message sender
ID or NO to announce the message sender ID.

12. In the Pin Retention (in days) box, type the number of days a user's PIN is valid
for before it expires.

13. In the Notify Before Pin Expires (in days) box, type the number of days prior to
the PIN Expiry date to begin alerting users that their PIN will expire.

14. In the Remote Message Notification list, select Yes to enable Remote Message
Notification or No to disable it.

15. In the Allow User To Edit RMN Phone# list, select Yes to allow a user to edit the
RMN phone number or No to disallow a user to edit the RMN phone number.

16. In the Hide Unknown Number in Message Envelope list, select Yes to hide
unknown number in the message or No to show unknown number in the
message.

17. Click Update to save your changes.
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Variable Definitions

Variable Value
COS No The Class of Service number.

Name The CoS name. The maximum length is 30
characters.

Maximum Message(s) to Keep The maximum capacity of the mailbox for
new and old messages.

 Important:
The range is 0 to 99 messages but Avaya
recommends that you keep no more than
50 messages.

Maximum Message Length The maximum recording length of a
message in seconds.

 Important:
The range is 0 to 999 seconds but Avaya
recommends that you do not exceed 600
seconds.

Number of Day(s) to Store New Messages The number of days to retain new messages.
The range is 0 to 999 where 0 is unlimited.
This is typically 0 so the user can decide how
to handle new messages.

Number of Day(s) to Store Old Messages The number of days to retain old messages.
The range is 0 to 999 where 0 is unlimited.
This is typically 0 so the user can decide how
to handle new messages.

Allow Message Broadcast Enable or disable sending messages using a
distribution list.

Personal Identification Announcement The Personal Identification Announcement
options are:

• NAME—the user's recorded name is
announced as the message sender. If no
recorded name is available, the extension
number is announced.

• NUMBER—the user's extension number is
announced as the message sender.

Anonymity Mode Select YES to remain anonymous while
sending messages. The system does not
announce the message sender ID, a generic
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Variable Value
prompt is played that does not provide the
sender name or number.

Pin Retention (in days) The number of days a PIN is valid for before
it expires.

Notify Before Pin Expires (in days) The number of days prior to the PIN expiry
date to begin notifying the user that their PIN
will expire. Type 0 (zero) to disable this
notification.

Remote Message Notification This feature is useful for users who are
frequently away from their desk. When you
enable the feature, the system calls the user
on a predefined number, such as the user’s
mobile or home number, as soon as a new
message is left for them. and the user can
retrieve the message on the same call.

Allow User To Edit RMN Phone# This feature allows a user to edit their
Remote Message Notification (RMN)
telephone number to change it to their
preferred telephone number.

Hide Unknown Number in Message
Envelope

This feature allows the system to hide or
show the unknown telephone number in the
message.

Configuring Guest Classes of Service
About this task
You can configure up to 20 Guest Classes of Service (CoS). CoS 0 is the default CoS and you
can configure CoS 1 to 20 as VIP classes.

Prerequisites:

• CoS 0 is the default Guest CoS and is for cases when no CoS is specified or assigned for a
room.

Procedure

1. On the Web Configuration main navigation bar, click Administration.

2. In the Administration navigation, in the Mailbox Maintenance section, click Guest
COS Configuration.

3. On the Guest Class of Service Configuration page, in the COS No list, select the
CoS number to configure.
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You can select an existing CoS or another number. You do not need to select
numbers in sequence.

4. In the Name box, type a meaningful name for the CoS.

5. In the Maximum Message(s) to Keep box, type the total number of new and old
messages to keep.

6. In the Maximum Message Length box, type the maximum message length in
seconds.

7. In the Number of Day(s) to Store New Messages box, type the number of days
to store new messages.

8. In the Number of Day(s) to Store Old Messages box, type the number of days to
store old messages.

9. In the Prompt Message Sender Name list, select YES to play the user's recorded
name or select NO to play the extension number.

10. In the Change Password list, select ALLOW to hear the Change Password prompt
or DISALLOW to disable the Change Password prompt.

11. In the Record Personal Greeting list, select ALLOW to hear the Record Personal
Greeting prompt or DISALLOW to disable the Record Personal Greeting prompt.

12. In the Set AWU list, select ALLOW to hear the Set AWU prompt or DISALLOW to
disable the Set AWU prompt.

 Important:
If using Communication Manager, configure Set AWU as DISALLOW.

13. In the Enable Welcome Message list, select YES to hear a welcome message
when a user accesses a mailbox for the first time or NO to disable the welcome
message.

14. If you enabled the welcome message, you can select the Turn MWL On When
There Is A Welcome Message check box to activate the MWL.

15. In the VIP AWU Feature list, select YES for an operator to manually make a wake-
up call to the guest or select NO for the system to place the wake-up call to the
guest.

16. In the Hide Unknown Number in Message Envelope list, select Yes to hide the
unknown number in the message or No to show unknown number in the
message.

17. Click Update to save your changes.

Configuring Guest Classes of Service
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Variable Definitions

Variable Value
COS No The Class of Service number.

Name The CoS name. The maximum length is 30
characters.

Maximum Message(s) to Keep The maximum capacity of the mailbox for
new and old messages.

 Important:
The range is 0 to 99 messages but Avaya
recommends that you do not keep more
than 50 messages.

Maximum Message Length The maximum recording length of a
message in seconds.

 Important:
The range is 0 to 999 seconds but Avaya
recommends that you do not exceed 600
seconds.

Number of Day(s) to Store New Messages The number of days to retain new messages.
The range is 0 to 999 where 0 is unlimited.
This is typically 0 so the user can decide how
to handle new messages.

Number of Day(s) to Store Old Messages The number of days to retain old messages.
The range is 0 to 999 where 0 is unlimited.
This is typically 0 so the user can decide how
to handle new messages.

Prompt Message Sender Name If you select YES, the system plays the user's
recorded name as the message sender or if
a recorded name is not available, the user's
extension number is played. If you select NO,
the user's extension number is played.

Change Password Enable or disable the Change Password
prompt.

Record Personal Greeting Enable or disable the Record Personal
Greeting prompt.

Set AWU Enable or disable the Set AWU prompt.

Enable Welcome Message The Enable Welcome Message option has
the following options:
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Variable Value

• YES - Welcome message is played when
a mailbox is accessed for the first time.

• NO - Welcome message is not played.

VIP AWU Feature The VIP AWU Feature option has the
following options:

• YES - The operator manually places the
wake up call for the guest.

• NO - The system places the wake up call
for the guest.

Hide Unknown Number in Message
Envelope

This feature allows the system to hide or
show the unknown telephone number in the
message.

Configuring an introductory message
About this task
Configure an introductory message that plays every time users access their mailbox. It is the
first prompt that is heard when users log into their mailbox. Once enabled, it is implemented
system-wide so that both admin and guest mailboxes hear this prompt.

Prerequisites:

• Record your introductory message prompt before activating this feature. For information
about recording introductory message prompts, see Avaya Hospitality Messaging Server
400 Front Desk Staff User Guide, NN42350-100.

Procedure

1. On the Web Configuration main navigation bar, click Administration.

2. In the Administration navigation, in the Introductory Message section, click
Activate Introductory Message.

3. On the Activate Introductory Message page, select the Enabled check box to
enable the introductory message.

4. Click Update to save your changes.

Configuring an introductory message
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Chapter 11: Common procedures

About this task
The chapter includes common procedures that you use when you install and commission the Avaya
Hospitality Messaging Server 400.

• Starting the Avaya Hospitality Messaging Server 400 server on page 111
• Stopping or restarting the HMS 400 — Full Shutdown on page 112
• Manually starting the Dialogic HMP service on page 114
• Starting the Web Configuration module in the Voice System application on page 114

Starting the Avaya Hospitality Messaging Server 400
server

About this task
Start the Avaya HMS 400 server.

 Important:
The HMS 400 cannot answer calls until the HMS400R3 window shows that channels are
ready. When Channels appear in the HMS400R3 window, the HMS 400 is ready to accept
calls.

Prerequisites:

• For more information, see Avaya Hospitality Messaging Server 400 Fundamentals,
NN42350-104.

Procedure

1. Ensure the HMS 400 server is properly connected to a power source.

2. Push the power button on the front panel of the server.
Windows 2008 Server automatically loads.

3. After Windows 2008 Server starts, the HMS 400 application automatically loads.

4. Wait approximately 5 minutes for HMS 400 to become fully operational. The Dialogic
Services must start before the HMS400R3 application starts.
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Stopping or restarting the HMS 400 — Full Shutdown
About this task
Follow this procedure to perform a full shutdown of the HMS 400 application or restart the HMS
400 application.

Procedure

1. On the HMS400R3: Voice System screen, go to Settings and check Stop Engine
when Shutdown.. This ensures that the voice engine stops running during
shutdown.

2. Click Exit.

3. In the Exit window, type the password 000.

4. Click Exit.

5. On the system tray, right-click the (not applicable to Communication Manager
systems). PMSI icon and select Exit.
Alternatively, open the PMSI application window, and click File > Exit. In the Exit
PMSI window, type the password 000.

6. On the system tray, right-click the PBXI icon and select Exit .
Alternatively, open the PBXI application window, and click File > Exit. In the Exit
PBXI window, type the password 000. (Not applicable to Communication Manager
system).

7. If the Operator Console application is active, select File > Exit on the ExtLink
Interface.

8. In the Exit Password window, type 000 and click OK.

9. Click Exit.

10. If Channel Monitor is active, select File > Exit in the Channel Monitor window.

11. To restart the HMS 400, double-click the HMS400R3 icon on your desktop.

 Note:
It takes 90 seconds before HMS400 Release 3 begins answering calls on a
restart.
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Stopping or restarting the HMS 400 — Partial Shutdown
About this task
You can partially stop the HMS 400 application when the following files need to be updated:

• voicesystem.exe
• voicelineprinter.exe
• voiceserver.exe

Procedure

1. On the HMS 400 application main screen, click Settings and make sure that Stop
Engine when Shutdown is not checked.

2. Click Exit .

3. Make necessary update to the files or replace the files with newer patches.

4. To restart HMS 400， double-click the HMS400R3 icon on your desktop.

Stopping or restarting HMS 400 modules
About this task
You can stop some HMS 400 modules individually when you need to update them. The
modules that can be stopped individually without impacting HMS 400 operation are as follows:

• PMSI
• PBXI
• ExtLink

Procedure

1. For an individual module, select File > Exit to shut down the module.

2. Make the necessary updatse to the file or replace the file with newer patches.

3. To restart the module, go to C:\HMS400R3\bin and search for the module to be
restarted.

• To restart PMSI, double-click on PMSI.exe.

• To restart PBXI, double-click on PBXI.exe

Stopping or restarting the HMS 400 — Partial Shutdown
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• To restart ExtLink, double-click on ExtLink.exe.

Manually starting the Dialogic HMP service
About this task
You can manually start the Dialogic HMP service if the service does not automatically start.

Procedure

1. Select Start > All Programs > Dialogic HMP > Configuration Manager DCM.

2. In the Configuration Manager window, if the green Play button is active, the
Dialogic service is active.
OR
If the red stop button is active, the Dialogic service is stopped or is in the process
of starting. If the Dialogic service is stopped, click Play to start it.

3. Ensure the Dialogic service starts.

4. Select Start > All Programs > Avaya HMS R3 > HMS400R3 to start the Voice
System.

Starting the Web Configuration module in the Voice System
application

About this task
Start Web Configuration from the Voice System application to configure options for your
system.

Prerequisites:

• Do not change the server name (hms400r3).
• Do not use the browser Back or Forward buttons to navigate pages. For security

purposes, caching is disabled and errors can occur if you use the Back and Forward
buttons.

Procedure

1. In the Voice System , click File > Launch Web UI.

2. In the Web UI window, in the User Type list, select Admin User.
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3. In the Admin User ID box, type the user ID.
The default is SuperAdmin.

4. In the Password box, type the password.
The default is abc123. Ensure that you immediately change this password.

5. Click Login.

6. If a Security Alert window appears, click Yes to proceed.

Starting the Web Configuration module in the Voice System application
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